
Gigabyte of disk and if 
its a USB external 
drive, an extra $20 for 
the case.  If you're putting the drive in 
a PC one of the things to watch is if 
the drive is ATA or SATA.  ATA is the 
more mature (I didn't want to say 
older) of the two interfaces. and is par-
allel.  SATA uses a smaller cable be-
cause it's serial and the cable has fewer 
wires in it. 
 
If you've been traveling with your lap-
top this summer hopefully you either 
have no personal information on it or 
you've taken some precautions to pro-
tect any data on the laptop hard disk.  
Remember any operation system log in 
only protects you from someone using 
the laptop.  The laptop hard drive is 
easily remove and place in a USB exter-
nal drive case available for $20.  Once 
the laptop hard drive is plugged into 
someone else's PC, they have full ac-
cess to all your files.  The only defense 
is no personal info on the hard drive 
or to have either the hard drive or the 
sensitive files encrypted.  I'd go with 
encrypting the hard drive because you 
enter the password once and then the 
drive works normally for everything.  
As with all passwords, don't write it 
down on a sticky note and fasten it to 
the laptop.  I'd write down the pass-
word, put it in an envelope, seal the 
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“Microsoft Equipt”  pre-
sented by Jeffrey Bates of 
Microsoft Corporation 

          The President’s Pen  
                 by Don VanSyckel 

W elcome back!  I hope each 
of you had a good summer.  
It passed way too quick for 

me.  I'm OK with heading into Fall but 
it's what follows that I'd like to avoid.  
Anyway summer is fun but each year 
that goes by it's a little more work to 
have fun.   
 
There's several things I'd like to men-
tion this month. First, Wayne State 
University is (or possibly by has) taking 
control of the Macomb County Library 
where we have SIG meetings.  I haven't 
really seen much about this but several 
people have filled me in.  We don't 
know what this will mean as far as our 
usage of the meeting room in either 
the short term or long term.  The only 
thing I know for sure is that the club 
has not been contacted  as of writing 
this with any information about the 
room reservations we have for the last 
four months of this year.  At this point 
it's all a guess but we're hoping to at 
least be able to finish out our current 
reservations.  We'll keep you posted 
about what's happening when we know 
something definite. 
 
Well in case you haven't out grown 
"forgetting everything over the sum-
mer" remember "Backup, Backup, 
Backup".  Well enough said about that 
except that hard drive prices continue 
to fall.  The rate of decline has slowed.  
My current rule of thumb is 20¢ per 

 



Page  2 

                       THE WYSIWYG                                                                                                         September   2008 

Associate  Editor             
Net/Comm. SIG 
Door prizes 
Greeter 
Newsletter publisher 
PC SIG 
Program Coordinator 
Publicity 
Resource People 
Vendor Press Rel. 
Web Page 
 

Rick Schummer 
Betty MacKenzie 
Sharon Patrick 
Lindell Beck 
Rick Kucejko 
Jack Vander-Schrier 
Jerry Hess 
Patrick Little 
open 
Jim Waldrop 
Don VanSyckel 
 

SHCC  Coordinators: 
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Firefox 
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WordPerfect 
Spreadsheets 

Rick Schummer 
Don VanSyckel 
Rick Schummer 
- 
Rick Kucejko 
Rick Schummer 
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Resource People: 

Guests and visitors are welcome. People can attend any SHCC meetings during two consecutive months before decid-
ing to become a member or not.  Meetings include the main meeting and SIGs.  July and August don't count since there 
is no main meeting.  Membership includes admission to all SHCC functions and the newsletter.  Membership is open to 
anyone.  It is not limited to the residents of Sterling Heights. 

  DUES:   $25/YEAR 

MS-DOS  (Main)                     
Net/Com 
           
PC 
 
 

IBM compatibles 
Computers communicating with         
other computers 
Intermediate users discuss various topics 
 
 

Special Interest Groups: 

Four  Month Meeting  Schedule: 

CLUB ADDRESS:  PO Box 385,  Sterling Heights, MI  48311-0385 
CLUB E-MAIL ADDRESS:  Info@SterlingHeightsComputerClub.org 
CLUB WEB PAGE: http://www.SterlingHeightsComputerClub.org 

As a member of SHCC, you can attend 
meetings of other clubs where we have 
reciprocating membership agreements, at 
no charge. 
 
Computer Club of Marysville and 
Port Huron (COMP) 
Time:   1st Wednesday, 7:00PM 
Place: Mackenzie Bldg, Room 201, St 
Clair Community College, Clara E 
McKenzie Library-Science Building, 
323 Erie St. 
Port Huron, (810) 982-1187 
Web Page: http://www.bwcomp.org 
Reciprocating: Yes 
 
 

Newsletter  submissions  are  due  10  days before the club meeting, but the 
earlier the better. They should be sent to : 
       WYSIWYG Publisher 
       5069 Fedora,  Troy, MI 48098 
OR at the e-mail addresses:  newsletter@SterlingHeightsComputerClub.org 

Unless stated otherwise, all materials contained in this newsletter are copyrighted 
by the Sterling Heights Computer Club. License is hereby granted to other clubs 
(non-profit) to reprint with credit. 

The WYSIWYG was printed by STERLING PRINTING  AND 
GRAPHICS, located at  35976 Mound, Sterling Heights, MI 48312. 

South Eastern Michigan Computer 
Organization (SEMCO) 
Time:    2nd Sunday at 1:30PM 
Place: ArvinMeritor Complex, 2135 
W. Maple Road in Troy, across from 
Troy Motor Mall; 248-398-7560 
Web page: http://www.semco.org 
Reciprocating: Yes 
The OPC (Older Persons Com- 
mission) Computer Club  
Time:   Every Tuesday at 10:00  
Place:  OPC in Rochester   
       248-656-1403.  
Web page: http://www.geocities.com/
Heartland/Village/1904/ 
No cost for residents to join or attend 
meetings. $150 fee for non-residents 
Reciprocating: No 

Other Computer Clubs: 

SEPTEMBER 2008 
2 -  SHCC -  “Microsoft 

Equipt”  presented by Jef-
frey Bates of Microsoft 
Corporation 

3     - COMP meeting 
14  - SEMCO meeting 
24  - PC SIG 
29  - Net/Comm SIG 
 
OCTOBER 2008 
7 -  SHCC -  “Explore TV and 
Video Online” presented by 
Jan Lauder from Troy Public 
Library 
1     - COMP meeting 
12  - SEMCO meeting 
20  - Net/Comm SIG 
29  - PC SIG 

NOVEMBER 2008 
4 -  SHCC -  "What's Hot for 
the Holidays" presented by 
Richard Tapaninen from Micro 
Center 
5     - COMP meeting 
9    - SEMCO meeting 
19   - PC SIG 
24   - Net/Comm SIG 
 
DECEMBER 2008 
2 -  SHCC -  "IPhone, IPod, 
ITouch, and Mobile Me" pre-
sented by Eric Blomberg from 
Apple Inc 
3     - COMP meeting 
8    - Net/Comm SIG 
14  - SEMCO meeting 
17  - PC SIG 
 

Lindell Beck 
Ron Frederick 
Jerry Hess 
Rick Kucejko 
Patrick Little 
Betty MacKenzie 
Sharon Patrick 
Rick Schummer 
Ed Trombley 
Don VanSyckel 
Jack Vander-Schrier 
 

586-939-4278 
586-294-5687 
586-566-6166 
248-879-6180 
586-264-1497 
586-254-0677 
586-268-3626 
586-997-1451 
586-254-1172 
586-731-9232 
586-739-7720 
 

ljaybeck48312@yahoo.com 
frederic@gdls.com 
jhess@comcast.net 
rick@kucejko.com 
pblittle@wideopenwest.com 
mackenzie79@comcast.net 
espee@wowway.com 
rick@rickschummer.com 
ejtrombley@comcast.net 
don@vansyckel.net 
jvanders@myself.com 
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SIG  Meetings 

Net/Comm  SIG  
 

T he next 
meeting of 
the Inter-

n e t / C o m m u n i -
c a t i o n s  ( N e t /
Comm.) SIG will be 
Monday, September 
29, 2008, starting at 

7:00PM at the Macomb County 
Library.  
 
Each month the members of the Net/
Comm SIG discusses topics to help 
members of the SHCC learn more 
about the Internet.  
 
For more information about the SIG, 
call or e-mail Betty MacKenzie (phone 
number is on page 2), or check the 
club web site. 

� � � � � 

� � � � � 

 Directions To The      
Macomb Library 

 

T he Macomb County Library is 
located at 16480 Hall Road, in 
Clinton Township, between 

Hayes and Garfield, close to the light 
at Garfield, on the south side of Hall 
Road. A large red sign says “Macomb 
County Library”. The phone number  
is  (586) 286-6660. 

� � � � � 

SHCC Emergency 
Shutdown 

 

I f a club meeting is canceled an 
email will be sent to members by 
an officer or the coordinator if a 

SIG meeting at least an hour before 
the scheduled start of the meeting.  If 
you have an issue with your email call 
one of the officers of the coordinator 
of the SIG.  Don't call too early, the 
decision might not be finalized yet.  All 
members are encouraged to keep the 
club up to date with their email      
address. 

More  Door Prizes 
 

H ave software you no longer 
use? It could make a good 
door prize for a fellow 

member. It would also give that 
member  another good reason for 
being glad to have been at the club 
meeting. Contact one of the officers, 
or just bring it. 

� � � � � 

� � � � � 

Club Record Changes 
 

T o update your e-mail address, 
phone number, etc., please      
e-mail the club secretary at: Sec-

retary@SterlingHeightsComputerClub.
org. Using this address will provide the 
smoothest and quickest venue for any 
changes. 

Attend  A  SIG 
 

I f you do not attend SIG meetings, 
you are missing out on important 
club benefits available to you. 

These small groups get into more detail 
and question and answer sessions than 
is possible at the main meeting. 

� � � � � 

PC SIG 
 

T h e  n e x t 
meeting of the 
PC SIG will be 

on Wednesday, Sep-
tember 24, 2008, start-
ing at 7:00PM at the 
Macomb Coun ty    

Library. The SIG meeting is generally 
the fourth Wednesday of the month.  
 
Intermediate level topics are discussed, 
aimed at users with some knowledge of 
computers. Questions and answers    
regarding your computer will be        
discussed as always.  
 
For more information about the SIG,  
call or e-mail Jack Vander-Shrier  (phone 
number is on page 2), or check the club 
web site. 

 

� � � � � 

Selling Your Used 
Computer Equipment 

or Software 
 

I f you have some computer equip-
ment or software to sell, you can 
either place a free ad in the 

WYSIWYG, or bring the article to the 
club meeting. You can set up at the 
back of the room before the meeting, 
and sell your items to people at the 
meeting interested in buying them.     
Members are responsible for any    
damage, so bring a pad to prevent  
damage. 

� � � � � 

Novice  SIG 
 
This SIG has been 
discontinued for now. 
All the Novice users 
have graduated to the 
Intermediate PC 
level!  
 

This SIG may be restarted in the     
future, when there is a need and suffi-
cient interest in the SIG. 

� � � � � 
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SHCC  Business  

� � � � � 

World Wide Web    
Column on the Club 

Web Site 
 

C heck out the improved section 
on the web site. You can see 
past web sites reviewed in the 

column on our club web page. They 
are arranged into various topics to help 
locate a specific site. 

Please send questions to 
“Ask the Experts” at the 
club’s PO address, or e-mail your 
question directly to the Expert at the 
club e-mail address: AskTheEx-
pert@SterlingHeightsComputerClub.
org. 

“Ask The Experts” 
by Jack Vander-Schrier 

Q : Dear Expert, 
 
Every time I open up my Inter-

net explorer it appears in a small box 
on my screen, I then have to resize it 
each time so that I can use it.   Is there 
any way to change the size of the open-
ing screen.    
 
Small Window 
 
 

A : Dear Small, 
 
Your browser remembers the 

size it was last used at.  To set the cor-
rect size – start your browser and hold 
your mouse over the corner of the win-
dow until you see the resize arrows, 
then click and drag to change the size.  
Then click on File – and then on Exit, 
this will close your browser. Now when 
you start it up it should be that same 
size. 
 
Sincerely 
Expert 
 
 
 
 

Q : Dear Expert, 
 
I want to buy some things on 

the Internet using my credit card. How 
do I know that I am secure before I 
send out my credit card information? 
 
Worried 
 

A : Dear Worried’ 
 
To know whether a site is se-

cure before you give your credit card 
information, look at the address bar 
and make sure that the web address 
starts with https://  There should also 
be a padlock symbol on the address bar 
or at the bottom of your screen.  If 
these aren’t there that means the web-
site is not secure and your information 
can be compromised. 
 
Sincerely 
Expert 

Door Prizes 
 

T he SHCC offers door prizes at 
most regularly scheduled club 
meetings. In June the names 

for the coveted winner’s circle were: 
 
1) Rick Kucejko -- T.B.D. 
2) Ralph Osinski -- T.B.D. 
3) Pat Little -- T.B.D. 
4) Lindell Beck -- T.B.D. 
  
Door prizes will be supplied to these 
people in September. 

� � � � � 

� � � � � 

Last Month's Meeting 
 

T he June meeting didn't go ex-
actly as planned.  We moved 
the meeting date to accommo-

date having Lifelock present.  Not only 
did they not show up but they never 
contacted us with any explanation or 
apology for standing us us.  So I'm as-
suming they run the rest of their busi-
ness with the same eye to detail, scary.  
Thanks to Ron Frederick, our VP, for 
leading a great question and answer 
session. 

The President’s Pen 

� � � � � 

� � � � � 

(Continued from page 1) 
envelope and hide it at home or give it 
to a trusted friend.  OBTW if you have 
an alternate method or a good encryp-
tion program, I'd like to hear from 
you. 
 
The other thing you should consider if 
traveling with a laptop is putting an 
address label on the bottom.  Include 
your phone number.  If you loose the 
laptop and an honest person finds it, 
an address with phone number allows 
them to contact you to make arrange-
ments to get the laptop back.  Of 
course if the person isn't honest they'll 
probably find your name and address 
on the hard drive anyway so the label 
isn't giving away much. 
 
I know you might have hear some of 
these tips before but are you doing 
them?  No, well that's why you needed 
to hear them again. 
 
This month we are please to welcome 
back Mr.  Jeffrey Bates from Microsoft 
Corporation.  Mr. Bates will present 
"Microsoft Equipt".  Come get the 
scoop on this interesting new product.  
Come get the straight scoop for Micro-
soft.  Hope to see you Tuesday. 
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(Editor’s Note: Bob Click used to be a 
member of the SHCC.) 
 
We worked the Cisco show <http://
www.cisco-live.com/> and they had 
over 700 computers setup. Classrooms 
were everywhere and, in spite of tight 
security, it was said that 26 laptops dis-
appeared one night. Security certainly 
got tighter after that. There were atten-
dees from many countries.  
  
“For those with gaming consoles, ei-
ther the X-Box 360 or PS3, 3-D avatar 
based interaction is being offered in 
the next several months. X-Box Live is 
Microsoft's system <http://tinyurl.
com/5awgjx> and Playstation Home is 
Sony's offering <http://tinyurl.
com/6xckoc>”   
 
*How’s Your Registry? 
WiseCleaner has released Wise Regis-
try Cleaner v. 3.6.2 and Wise Disk 
Cleaner V. 3.5.1, a pair of affordable 
Windows applications that stabilize 
your computer, and make it run more 
quickly. Wise Registry Cleaner speeds 
up the user's computer by cleaning the 
Windows Registry. The Registry is at 
the heart of every Windows computer. 
Each time users install new software, 
information is added to the Regis-
try. Few uninstall programs remove 
this information properly or com-
pletely. Therefore, over time, as users 
install and uninstall software, the Reg-
istry accumulates junk lines and point-
ers, and the computer's performance 
suffers. 
 
Wise Registry Cleaner identifies and 
safely removes the useless information 
that has accumulated. In addition to 
scanning and cleaning the Windows 
Registry, the program optimizes the 
PC. If the user accidentally makes a 
mistake during a tune-up, they can 
undo all changes with a single click. 
The latest version of Wise Registry 

Cleaner includes a useful feature: 
"System Optimization Tool." Using 
this tool, users can easily tune up their 
PC in minutes without being a PC ex-
pert! [DealsGuy note: Optimize Your 
PC appears to only be in the Pro ver-
sion.] 
 
Wise Disk Cleaner is an intuitive, fast, 
and easy-to-use application that frees 
up disk space by deleting files no 
longer used by any software. In addi-
tion to the temporary files, log files, 
and backup files that accumulate over 
time, the program can identify more 
than 50 additional types of unneces-
sary files that users can safely remove. 
Instead of sending deleted files to the 
recycle bin, the program can compress 
these files and save them to a special 
directory, allowing users to restore files 
in the future if they find that they 
really need them. The latest version of 
Wise Disk Cleaner contains additional 
advanced customization options that 
let users fine-tune cleanup operations. 
[DealsGuy Note: Move To Location 
and Advanced Options appear to only 
be in the Pro version.] 
 
Both applications are designed to be 
used in tandem, allowing users to 
streamline their Windows Registry and 
optimize their hard drive. Whether 
you are a business user who values a 
stable and brisk computer, a parent 
who needs to clean up after the soft-
ware that their children install and 
uninstall on the family computer, or a 
computer consultant who needs appli-
cations that will keep their customers' 
PCs running optimally, Wise 
Registry Cleaner and Wise Disk 
Cleaner have the tools that you need. 
 
Wise Registry Cleaner and Wise Disk 
Cleaner also offer support for more 
than twenty languages. It’s easy to add 
additional language support into Wise 
Registry Cleaner and Wise Disk 

Cleaner. The User Interface messages 
are loaded from resource files for all 
supported languages. This means that 
you can add a resource file that con-
tains messages in your own language.  
 
Please note that there are FREE ver-
sions of both Wise Registry Cleaner 
and Wise Disk Cleaner. You can 
choose to pay for the PRO version, or 
only use the free version if pre-
ferred. Wise Registry Cleaner V. 3.6.2 
and Wise Disk Cleaner V. 3.5.1 run 
under Windows 98/Me/NT/2000/
XP/XP-x64/2003/Vista/Vista-
x64/2008 Server, and cost $19.95 (US) 
each. As a bundle, users can buy both 
programs for $32.95. Everybody can 
visit <http://www.wisecleaner.com/> 
to purchase the software securely 
online, or to download free trial ver-
sions. Users can also download free 
versions of each program without the 
advanced options and system optimiza-
tion tool. 
 
*If You Don’t Understand, Try This 
LingvoSoft <http://www.lingvosoft.
com> announced the release of an all-
new language learning system for 
Pocket PC that makes speaking any 
language simple, fast and enjoyable. 
Putting everything you need in the 
palm of your hand, LingvoSoft Lan-
guage Teacher 2008 makes communi-
cating in a new language easier than 
ever before. Providing every beginner 
with the tools necessary to start speak-
ing another language immediately, 
your success is virtually guaranteed. 
  
With intuitive and efficiently arranged 
sections that teach the alphabet, words, 
phrases, and dialogs you will soon have 
the skills you need to start speaking 
accurately and comprehensibly. With 
the advanced voice output and speech 
recognition built-into the Language 
Teacher you will always get the pro-
nunciation right the first time, some-
thing new learners absolutely depend 
on. Loads of practice tests and evalua-
tions provide the help new students 
need to start mastering any language 

From The DealsGuy 
by Bob (The Cheapskate) Click, Greater Orlando Computer Users Group. 
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immediately. The price is $149.95, but 
a 25% discount is available on any 
LingvoSoft software title. Simply enter 
your personal gift certificate code 
"MY8UZPF7M4" in the 'Add Gift' field 
of the shopping cart and click the "Add 
Gift" button <http://www.lingvosoft.
com/info/software/Language-
Teacher/>. 
 
*This Should Help You Copy 
[DealsGuy Note: Be sure to thoroughly 
read the FAQs on their Web site so 
you more fully understand the capabil-
ity of the product.] 
 
DVD neXt COPY released version 
V2.9.9.1 of DVD neXt COPY, a new 
and improved version that has the best 
quality of any DVD Copy software 
available. DVD neXt COPY triggers 
the quality king and jumps over the 
magical quality hurdle of the legendary 
DVDShrink. Until now the "old" 
DVDShrink possessed the best quality 
of any DVD copy program available. It 
was impossible for any competitors to 
reach this high level of quality and 
speed. As of now, DVD neXt COPY 
has broken through this barrier, and 
provides better quality and faster burns 
than DVDShrink (High Quality 
Mode). 
 
DVD neXt COPY now provides the 
highest quality of any DVD copy soft-
ware available. Our extensive quality 
check was preformed on the majority 
of the latest DVD movies with excel-
lent results. We have compiled test 
report on two special movies that are 
often used as quality reference movies, 
because they are very complicated to 
recompress. You can see our results in 
this test report: <http://www.
dvdnextcopy.com/
quality_messurement.pdf>. 
 
During this special promotional pe-
riod, everyone can receive 20% off 
DVD next COPY Xpress, Standard 
and Pro. Just enter the word "SAVE20" 
in the coupon field during purchase, to 
receive your 20% discount. Prices are 

as follows: XPress $49.99, Standard 
$69.99, Pro $89.99. The license is 
good for two computers but does re-
quire activation. Read more informa-
tion about the new DVD neXt COPY 
at <http://www.dvdnextcopy.com> 
Watch the online DVD neXt COPY 
flash tutorials at <http://www.
dvdnextcopy.com/tutorials.aspx>. 
 
Release Date 6/24/08 
V2.9.9.1 
Improved Quality Engine 
Improved Software Compatibility 
Mode 
Added Pre-scan Preview Function 
Updated Resources to V2.9.9.1 
 
Product page link: <http://www.
dvdnextcopy.com/overview.aspx> 
 
*What’s That Key? 
Everybody knows Windows has a prod-
uct key used to install it. If you needed 
it for some reason, do you remember 
where you put it? It also ends up em-
bedded in your registry so maybe you 
could edit your registry if necessary to 
retrieve it, but that’s living danger-
ously. The Magical Jelly Bean Key-
finder V2.0.1 is a freeware utility that 
will go in and get it for you. It has op-

� � � � � 

tions to copy the key to your clipboard, 
save it to a text file or print it for your 
records. It works on a wide family of 
Windows operating systems. 
 
It also has support for multiple installa-
tions of Office, and the ability to 
change the Windows XP, 98 and ME 
installation key. It’s at <http://
magicaljellybean.com/keyfinder/>. 
Also offered is a neat popup dictionary 
that is freeware. I read about these 
long ago in Tim Hoke’s freeware col-
umn in PC Alamode, newsletter for 
Alamo PC Organization <http://www.
alamopc.org/index.shtml>. 
 
That's it for this month. I’ll have some 
other new product announcements on 
my Web site. Meet me here again next 
month if your editor permits. This col-
umn is written to make user group 
members aware of special offers or free-
bies I have found or arranged, and my 
comments should not be interpreted to 
encourage, or discourage, the purchase 
of any products, no matter how en-
thused I might sound. Bob (The 
Cheapskate) Click <bobclick at bell-
south dot net>. Visit my Web site at 
<http://www.dealsguy.com>. 

D o you really know how to for-
ward an e-mail? It is estimated 
that over fifty percent of        

e-mail users do not know how to do it 
properly. Do you wonder why you get     
viruses or junk mail? E-mail messages 
get forwarded countless times without 
concern for the security of the previous 
sender’s addresses.  
Every time you forward an e-mail there 
is information left over from the peo-
ple who got the message before you, 
namely their e-mail addresses and 
names.  As the messages get forwarded 
along the list of addresses builds and 

E-mail Etiquette 
by John Roy, President, The PC Users Group of Connecticut 

www.tpcug-ct.org/   johnroy1(at)comcast.net 

builds creating a huge resource for 
spammers. All it takes is for someone 
to get a virus and the infected        
computer can send that virus to every 
e-mail address that has come across 
that computer. Even if the address col-
lection doesn’t result in a virus it surely 
will be harvested by spammers or some-
one looking to make a couple of cents 
for a listing of good e-mail addresses. 
How do you stop or at least minimize 
the propagation of e-mail addresses? 
There are several easy steps that we 
should all practice. 
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� � � � � 

E-Mailing Photographs 
by Richard Kennon, Editor, Amador Computer Users Group, CA 

www.acug.net    Drtrdguy(at)volcano.net 

file size may be several megabytes. Our 
screens are usually only about 1000 
pixels wide (some are larger and some 
smaller). So, if we e-mail the native  
picture, it will be wider than the screen 
for the recipient and the file will be so 
large, it may take “forever” to 
download to the recipient’s computer. 
It is possible the service provider will 
not even accept it. 
 
There are two things we must do to 
make a photo e-mailable. The first is to 
resize or resample the picture. We 
want to change the picture width from 
3000 pixels to 800 pixels, for instance. 
This process is called resizing or resam-
pling. We have to pick the best 800 
pixels out of the 3000 to represent our 
photo. Well, no, that is not exactly cor-
rect but it simplifies things to think of 
it that way. We don’t have to worry 

Obtained from APCUG with the au-
thor's permission for publication by 
APCUG member groups. 
 

F irst, we must understand that 
photograph (image) size in the 
camera and in the computer is 
measured in pixels. These are 

the basic dots of color that make the 
picture. Do not pay any attention to 
anything that says “inches” or “pixels 
per inch.” These terms are meaningless 
when we are considering a picture    
either in the camera or in the com-
puter. They may come into play later if 
we want to print the photo on paper. 
But, that is another subject for another 
time. For now, we think only of pixels. 
Most cameras record too many pixels 
to e-mail. For instance a 6 megapixel 
camera will make a picture about 3000 
pixels wide by 2000 pixels tall and the 

(1) Before you send out a forwarded e-
mail, DELETE all of the other ad-
dresses that appear in the body of the 
message (at the top). That's right, DE-
LETE them. Highlight them and     
delete them, backspace them, cut 
them, whatever it is you know how to 
do. It only takes a second You MUST 
click the ‘Forward’ button first and 
then you will have full editing capabili-
ties against the body and headers of 
the message. If you don't click on 
‘Forward’ first, you won't be able to 
edit the message at all. 
 
(2) Whenever you send an e-mail to 
more than one person, do NOT use 
the To: or Cc: fields for adding e-mail 
addresses. Always use the BCC: (blind 
carbon copy) field for listing the e-mail 
addresses. This is the way the people 
you send to will only see their own     
e-mail address. If you don't see your 
BCC: option click on where it says To: 
and your address list will appear. High-
light the address and choose BCC: and 
that's it, it's that easy. When you send 
to BCC: your message will automati-
cally say ‘Undisclosed Recipients’ in 
the ‘TO:’ field of the people who    
receive it. 
 
(3) Remove any ‘FW:’ in the subject 
line. You can re-name the subject if 
you wish or even fix spelling.  
 
(4) ALWAYS hit your Forward button 
from the actual e-mail you are reading. 
Ever get those e-mails that you have to 
open 10 pages to read the one page 
with the information on it? By forward-
ing from the actual page you wish 
someone to view, you stop them from 
having to open many e-mails just to see 
what you sent.  
 
(5) Have you ever gotten an email that 
is a petition? It states a position and 
asks you to add your name and address 
and to forward it to 10 or 15 people or 
your entire address book. The e-mail 
can be forwarded on and on and can 
collect thousands of names and e-mail 
addresses. A FACT: The completed 

petition is actually worth a couple of 
bucks to a professional spammer be-
cause of the wealth of valid names and 
email addresses contained therein. If 
you want to support the petition, send 
it as your own personal letter to the 
intended recipient. Your position may 
carry more weight as a personal letter 
than a laundry list of names and e-mail 
address on a petition. (Actually, if you 
think about it, who's supposed to send 
the petition in to whatever cause it sup-
ports? And don't believe the ones that 
say that the e-mail is being traced. It 
just isn’t so!)  
 
(6) One of the main e-mails I hate is 
the one that say that something like, 
‘Send this e-mail to 10 people and 
you'll see something great run across 
your screen.’ Or, sometimes they'll just 
tease you by saying something really 
cute will happen IT AIN'T GONNA 
HAPPEN! (Trust me; I'm still seeing 
some of the same ones that I waited on 
10 years ago!) I don't let the bad luck 

ones scare me either. They get trashed. 
(Could that be why I haven't won the 
lottery?)  
 
(7) Before you forward an Amber 
Alert, or a Virus Alert, or some of the 
other ones floating around nowadays, 
check them out before you forward 
them. Most of them are junk mail that 
have been circling the net for years. 
Just about everything you receive in an 
e-mail that is in question can be 
checked out at Snopes. Just go to 
http://www.snopes.com/. It’s really 
easy to find out if it's real or not. If it's 
not, don't pass it on.  
 
So please, in the future, let's stop or at 
least minimize the junk mail and the 
viruses by taking the steps outlined 
above. 
 
This article has been provided to AP-
CUG by the author solely for publica-
tion by APCUG member groups.  
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Member  Classified 
Ads 

 s end   any  classifieds  to the  
WYSIWYG   Publisher  at the 
club’s  PO  Box,  or  to  his       

e-mail address posted  on page 2 of the 
newsletter.  
 
Ads are available to SHCC members 
and are limited to computer related 
items for non-commercial purposes. 
There is no charge for members 
classified ads.  

� � � � � 

about it because a lot of very smart pro-
grammers have developed ways 
(algorithms) to help us. Just remember, 
you want to resize or resample to get 
the photo down to a size convenient 
for e-mailing. I usually use 800 pixels 
or 900 pixels width for pictures I     
attach to e-mails. 
 
The second thing to do to make a 
photo e-mailable is to save it in JPEG 
format (.jpg). That is a format that re-
duces file size a lot and picture quality 
a little so the picture can be 
downloaded more quickly and still be 
nice to look at. Some software pro-
grams give you choices of compression 
amount with numbers ranging from 1 
to 10. One will result in a very small 
file but the picture quality will not be 
good at all. A 10 will give the very best 
quality but with a very large file size. A 
reasonable compromise is to use 5 or 
6. I usually use 6. 
 
How do you do this? First, I will      
describe how to do it with a free Micro-
soft program. Then I will try to look at 
some other programs. 
 
Microsoft Power Toys for XP has a  
Resize Pictures toy that is slick and easy 
but feedback says it only works on XP. 
It can be downloaded at http://www.
m i c r o s o f t . c o m / w i n d o w s x p /
downloads/powertoys/xppowertoys.
mspx. Right click on an image name or 
thumbnail in Explorer or My Com-
puter and choose Resize Pictures. You 
are limited to four specific sizes but 
they are good choices. They don’t tell 
us what compression they are using but 
the results look OK. Unless you tell 
them under Advanced to replace the 
image in the file, it will make a copy. 
That’s good. They will add the word, 
“Large”, “Medium” or “Small” to the 
end of the name you have chosen. 
 
If you are happy with this solution, 
then read no further. But, if you want 
to use a picture editing program, 
maybe this will help. 
 

In Photoshop Elements 5, click on Im-
age>Resize>Image Size and this win-
dow will pop up. Note that there is 
some garbage at the bottom about 
“inches” but we will ignore that. First 
we will click the Resample Image box. 
That puts the Pixel Dimensions in play 
and that is what we want. I selected the 
Width box and changed the width to 
800 pixels. Since the Constrain Pro-
portions box is selected, that is all I 
have to do.  
 
Note, down at the bottom, that we 
have several choices of sampling algo-
rithms. This is frosting on the cake. I 
read somewhere that I should use   
Bicubic Sharper when downsizing so 
that is what I do. Most programs don’t 
give us all these choices. Then we 
should click on File>Save As and give 
the photo a new name. I often just use 
the same name and add “_800px” so 
the next time I will know it is ready to 
e-mail. Here we can choose the JPEG 
format and the compression amount. 
Photoshop Elements 6 is out now and 
sells for about $100. If you are able to 
spend that much and want one of the 
best editing programs, I highly recom-
mend it. 
 
Let’s look at Picasa2. It is a free pro-
gram from Google and looks really 
good but I do not have much experi-
ence with it. By all means, try it first 
because the price is right. When it 
comes to e-mailing photographs, it is a 
little more automated but not any   
easier to use than Elements. First, click 
on Tools>Options>E-Mail. Then select 
the width you want in pixels. There are 
six choices. Then click on Apply and 
OK.  
 
The next step is to click on File>E-Mail 
and you will get three choices of how 
you want to e-mail your photos. Fortu-
nately, I use Outlook Express so my 
choice is listed. 
 
When I clicked on Outlook Express, 
an e-mail page popped up with the 
photo attached. At this point we can 

write something else on the e-mail and 
send it. I recommend this so the recipi-
ent will know it is really from you and 
not something sent out by a virus. 
When I receive e-mails that only say 
“Attached”, I Delete them without 
looking at the attachment. This saved 
me one time when I received a virus 
from my sister-in-law that she did not 
know she sent. She spent weeks and 
dollars getting her computer back up. 
Oh, I digress. If you want to send more 
than one picture (and, who doesn’t?), 
you must select the picture and click 
on the Hold button near the bottom of 
the screen. Do this for each photo you 
want to send and they will all be at-
tached to the e-mail. The program 
automatically chooses JPEG format 
and a compression ratio but does not 
tell you. That is OK as the pictures I 
tried looked good. Picasa2 has consid-
erable capability for editing photos in 
many respects. Try it! 
 
There are many other editing programs 
that I haven’t mentioned and have no 
experience with. In all cases you want 
to change the picture’s size in pixels by 
resizing or resampling. Pay no atten-
tion to anything that says “inches” as 
that will have no meaning for this 
process.  
 
This article has been provided to     
APCUG by the author solely for pub-
lication by APCUG member groups.  
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 WYSIWYG WEB WATCH (www) 
By Paul Baecker 

webwatch@sterlingheightscomputer 
club.org 

This column 
attempts to lo-
cate sites con-
taining valuable, 
amusing and 
free content, 
with no over-
bearing pressure 
to purchase any-

thing.  Send your favorite entertaining, 
helpful or just plain useless sites (a de-
scription is optional) to the e-address 
noted above, for inclusion in a future 
WYSIWYG issue.  Also check the 
SHCC web site (“Web Page Reviews”) 
for previous gems.   

Convert boring units to real objects as 
you type. 
http://www.sensibleunits.com 
 
Basic & scientific calculator with unit 
converter.  Watch the demo. 
http://www.ecalc.com 
 
Collection of maps & grids represent-
ing political polls for prez, house, sen-
ate races. 
http://www.electoral-vote.com 
 
Tutorials, tricks, tools, and shortcuts 
for new Vista users. 
http://www.vista4beginners.com 
 
Make a paper rose. 
http://hotcompare.com/2008/07/08/
prison-breakuse-paper-make-a-roses.
html 
 
Once loaded, this online alarm clock 
will work even if Internet connection 
goes down.  
http://kukuklok.com 
 
Virtual absinthe museum -- history, 
literature, art and antiques. 
http://www.oxygenee.com/absinthe-
museum.html 

Tourist destination guide to the Niag-
ara Falls area. 
http://www.infoniagara.com/index.
html 
 
Search engine for free photos from 
many sources and license-specific. 
http://www.everystockphoto.com 
 
Find out what it is that you fear. 
http://www.phobiaguide.com 
 
Six hundred videos and 1 million pho-
tos of commercial and military aircraft 
and airports. 
http://www.jetvideos.net 
 
Browse airlines, airports, meals, seats, 
lounges, and aircraft news. 
http://www.flyerguide.net 
 
Australian scenery, flora, fauna, the 
outback, architecture, more. 
http://www.photographsofaustralia.
com 
 
A large gallery of very strange things. 
http://www.sl ightlywarped.com/
crapfactory/curiosities/index.htm 
 
Guide to installing, dual-booting, using 
Ubuntu 8.04 . 
http://ubuntuguide.org/wiki/Ubuntu:
Hardy 
 
Throw the people in the bucket.  No, 
it’s not that easy. 
http://www.pplbucket.com 
 
1950s pics around Altoona, PA -- rail-
roads, autos, downtown, storefronts, 
ads, more. 
h t t p : / / p a g e s . p r o d i g y . c o m /
altoonaarchives/ 
 
Michigan’s Copper Country history 
and beauty.  Start with the 1100-photo 
image gallery. 
http://www.copperrange.org 

U.S. & World events, sports, econom-
ics, science, entertainment events since 
1900. 
h t t p : / / w w w . i n f o p l e a s e . c o m /
yearbyyear.html 
 
Over 18,000 NASA images -- universe, 
solar system, earth, aeronautics, astro-
nauts. 
http://nasaimages.org 
 
Dramatic photos from above. 
http://www.submitarchive.com/
upload/pictures_from_the_sky.php 
 
Assortment of unusual air, sea and 
land vehicles pics and poses. 
http://www.strangevehicles.com 
 
Hold down mouse button to create 
colorful shapes using the available tem-
plates. 
http://bomomo.com 
 
Web search tool which flips full 
screens with search results. 
http://www.searchme.com 
 
Large colorful collection of agates, plus 
scenery of Britain, Scotland, Cambo-
dia, Turkey. 
http://www.lithos-graphics.com 
 
Test your knowledge of popular music 
with this audible challenge. 
http://www.jamsbio.com/games/
songBlitzSolo 
 
Click on the ball to change its color. 
http://mazzanet.id.au:80/ball.php 
 
Learn how to express yourself in Ger-
man -- grammar, pronunciation, verb 
conjugation, vocabulary, more. 
http://www.germanlanguageguide.com 
 
Digital camera and lens reviews with 
video tours of equipment. 
http://www.cameralabs.com 
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